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1 - Introduction  
 

AssetGen Visio Utils is a Visio add-in to help users be more productive. The controls provided by this 

add-in are targeted towards individuals looking to draw diagrams that are centred around data 

centre management, planning and documentation. 

The main features are: 
 

• DC Layout - Automating the resizing of shapes for scaled data center floor plans and 
automating the layout of cabinets in floor plan diagrams into rows (horizontally or 
vertically) 
 

• DC Floor Tiles – Automating the creation of a grid of shapes such as is often used for floor 
tiles, as well as the application of a sequence of numbers or letters to selected shapes. 
 

• Diagram Linker – Automatically links shapes on the current diagram to pages in “details” 
diagrams. 
 

• Diagram Publisher - Automatically saving diagrams to HTML (web) pages with appropriate 
data graphics applied to each page 
 

• Diagram Organizer - Selecting and filtering hierarchical diagrams of shapes to allow trees 
or related shapes to be selected, and filtered (to hide unrelated shapes) 
 

• Network Organizer – Laying out connections for network topology diagrams, including 
automatic spacing, and being able to turn port names on or off – very useful for showing 
switch or patch panel patching diagrams. 

 

 

These controls are made available through a Ribbon tab (Visio 2010-2016). 
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2 - DC Layout: Laying out cabinets on a page 
 

The first thing to press when starting to use these controls is to click the small button located next to 

the DC Layout Label, at the bottom right corner of that group.  

This results in a DC Layout Options window popping up and allowing you to set properties applicable 

to your needs. 

 

 

 

 

 

 

 

 

 

 

 

 

Shape Name Property - This is the name of the shape data property that is used to calculate which 

row or column the “cabinets” should be placed. For cabinets, it is usual for this to be “Cabinet 

Name”. 

 

Gap between rows/cols - The vertical gap between rows, or the horizontal gap if laying out columns. 

The unit of measurement must be specified in standard Visio abbreviations: 

• mm  -  Millimeters 

• cm -  Centimeters 

• m  -  Meters 

• km -  Kilometers 

• in  -  Inches 

• ft   - Feet 

• mi  - Miles 

For cabinets, the measurements most used would be mm, cm, m, in or ft. 

 

Size Units - If set to Auto (the default), then this reads the value in Page Setup > Measurement Units. 

It will use millimeters if the Visio page is scaled in metric units, and inches if the page is scaled in 

inches, feet or imperial units. 
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 If set to mm, then suitable values for Cabinet Width/Depth might be 800/1000. If in inches then 

they might be 32/40. 

 

2.1 - Resize Horizontally / Resize Vertically 
 

To use this feature, the selected shape requires shapes data to include the words Width or Depth. 

Shape data can be included to a shape by two methods, importing a spreadsheet via Data (in the top 

section) -> Quick Import, or by Right Clicking the shape -> Data -> Define shape data and adding 

data to the fields you define. 

 

Select the shapes you want to resize and click either the Resize Horizontally or Resize Vertically 

button. The feature requires that the shapes have shape data that have labels which include Width 

and Depth with values of the required sizes. 
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2.3 - Layout Cabinets 
 
This control places out the cabinets in the desired direction. The requirement for this controls is that 

the user has already indicated the shape data that is used as the name property of a shape. This is 

done via the DC Layout Options window, which was mentioned previously in the document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking any of these buttons displayed in the list will rearrange the shapes in the specified order.  
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3 - DC Floor Tiles 
 

Create Grid from shapes allows the creation of data centre floor tiles through generating columns 

and rows of the selected shape. 

 

3.1 - Create Grid from Shape 
 

Displayed below is the control that is clicked to bring up the Create Grid from Shape window. 

 

 

 

 

 

  

 

 

 

Width/Height Properties - These show the current dimensions of the selected shape. If you change 

them then you can click the Resize button to resize the shape to the new dimensions. 

 
Columns (X)/Rows (Y) - the number of times to duplicate the shape. 

 
Extra spacing - this defaults to 0 (zero). If you set it to a value greater than 0 then the shapes will 

have extra space between them – so their edges will not be right next to each other. 

 
Start shape is - this is one of the following values. 

• Top Left Corner – start top left and create a row from left to right and then columns from 
top to bottom. 
 

• Top Right Corner – right to left, top to bottom. 
 

• Bottom Left Corner – left to right, bottom to top. 
 

• Bottom Right Corner – right to left, bottom to top. 
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Apply/Undo – The Apply button creates the grid. If you then click the Undo button, then the grid will 

be undone, leaving just the original selected shape. This is useful in case you make a mistake and 

want to change the number of columns or rows. 
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Auto Number/Letter selected shapes. Using this option, it is easy to apply a simple numbering or 

lettering scheme to selected shapes – as shown we have number 20 squares 01-09. Numbering them 

AA-AI would be just as easy, or alternatively “Step 01” to “Step 20” using the Prefix. 

 
Dialog options are: 

Auto-number/Auto-letter - Number and letter are as explained below – they enable the 

appropriate options. 

 
Set text - this allows you to set whatever value is in Prefix Text as the text for all selected 
shapes. If Prefix Text is blank then it clears the text for all selected shapes which can be 
useful. 
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Start with - for numbering this value is the start number, with leading zeroes kept, so you can 

have 1, 2, 3 or 023, 024 etc. 

For Letter sequences this can be any letter A-Z, and you can also have leading letters, e.g. AA, AB, 

AB, or BCY, BCZ, BDA  

 
Step - numeric value between numbers in the sequence (not valid for Lettering), thus creating a 

sequence 10, 20, 30 is easy. 

 
Text Prefix - any text you wish to put on the start of every label, e.g. “Step” or “1/” or whatever. 

Remember trailing space if you want it. 

 
Preview - shows you the first couple of labels in the current sequence to check you are getting 

the results you wanted with the combination of other fields. 

 
Directions: 

• Left->Right 

• Right->Left 

• Top->Bottom 

• Bottom->Top 

 
Apply / Undo – perform the labeling, or undo the last labeling action (normal undo also works 

after you have closed the dialog). 

 
The create grid isn’t only restricted to squares, you are able to generate multiple shapes and label 

them, for instance with the control you would be able to create the following group of shapes. 
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4 - Diagram Linker 
 

This is a powerful feature for automatically creating links from shapes in a Master Visio document to 

pages within details documents. 

An example we often come across – being able to link cabinets in a floor plan to the individual 

cabinet diagrams within one or more “details” Visio documents. 

 

 

This controls will look into the files specified in the Details files section of the Link to Sub-Diagram 

window, and by using the “Link property” value as a reference it adds a hyperlink to all the shapes 

that it has found a reference to in the files. 

 

This allows you to easily create a hierarchy of documents with “drill down” capability from higher 

level overviews to lower level details. 

 

Examples of such drill down hierarchies include: 

• Cabinets on floor plans linking to cabinet (or rack) diagrams 
 

• Rack diagrams linking to hardware build of chassis devices 
 

• High level network diagrams to lower level detailed diagrams 
 

• Service diagrams linking to detailed functional architectures 

• Process charts 
 

• Making it easy for non-experts to find the detail they want 
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Other reasons for linking diagrams include: 

• Breaking down large Visio files into more manageable smaller ones 
 

• Separating overview and detail diagrams to support information security requirements 
(restricting access to details for some people) 
 

• Dividing responsibilities for maintaining a set of diagrams among local groups 

 

 

 

 

 

 

 

 

 

 

 

 

Diagram Linker dialog - These are the options as explained below. 

 

Master file – this is the name of the current Visio diagram – it cannot be changed (although you can 

open a new Visio diagram and perform the Link action from that diagram). 

 
Current Page/All Pages – you can select which pages in the current document to process. 

 
Link property – this is populated with a list of all possible shape data property names that you can 

select. In this example the field “Cabinet Name” will be used (the default). 

 
Link prefix – this is the name for the hyperlinks inserted. If multiple details files are selected, then a 

numeric value is appended to this prefix. 

 
Detail files – browse to select one or more details files to parse. These files are not modified in any 

way. The module just reads them to find a list of all the page names which match the selected “Link 

property”. 
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Use relative pathnames – If checked, and the details file is in the same directory as the master file, 

then just the filename (without its full directory path) will be used for the link. This allows you to 

move both files to another directory and have links work correctly. 

 

Clicking the link button will perform the linking and update the progress bar at the same time: 

 

 

 

 

 

 

 

 

Diagram Linker - Cabinet shapes on a floorplan may have multiple hyperlinks inserted to detailed 
cabinet diagrams as shown above. In this example, the cabinet has shape data where the field 
“Cabinet Name” is set to “01-02”. If we Ctrl + Click on the shape we see several hyperlinks. By clicking 
on one of those hyperlinks we open the detailed cabinet diagram (in a separate Visio documents), 
and on the corresponding page (01-02). 
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5 - Diagram Publisher – Saving pages for the web 
 

When you use “Save As…” to create a web page, Visio allows you to save one or more pages in the 

current document as they are currently shown. 

However, if you have shape data then you may use data graphics so that the same diagram can show 

data in various ways. For example: 

 

 

The above diagram shows the same cabinets with 3 different data graphics applied: 

• Cabinet Function - it is very common to allocate a whole rack to a function such as Network 
equipment or server equipment (for cabling and patching purposes). 
 

• Power Feed Status – the first bar shows the design limits in Amps, while the second bar 
shows current usage – indicates cabinets that may be approaching their limits. 
 

• Power Status – shows the sum of power (in Watts) for the equipment they contain, and 
whether that exceeds the design limits. 

 

5.1 - Learning About Data Graphics 

There are plenty of articles and it is well covered in various Visio books. You can start with here. 

 

 

 

 

http://office.microsoft.com/en-us/visio-help/enhance-your-data-with-data-graphics-HA010048784.aspx?CTT=5&origin=HA010182979
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5.2 - Apply Data Graphics 

The “Apply Data Graphics” button brings up the dialog below: 

 
Apply Data Graphics. This button allows you to specify which of the various data graphics defined in 
the current document should be applied to each page in the document. 

 
This can be very useful function, particularly if you have a document with many pages and wish to 

apply a data graphic to each of the pages in the document. 

 

5.3 - Saving as HTML or PDF 

If you have multiple data graphics in your Visio diagrams, then to save as a web page, you would 

need to manually apply the data graphics and then click save, each time remembering to use a 

different file name. This can be painful if: 

• You have multiple pages each of which has several different applicable data graphics 
 

• You have a few data graphics in the document but many pages, e.g. a diagram containing 
server racks at one per page, with tens or hundreds of pages. 

 

The AssetGen Visio Utils “Save as Web/PDF” button brings up the following dialog: 
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Each page is shown in the hiearchy, and for each page, it automatically lists the names of the 

applicable data graphics (it detects automatically which data graphics are applicable/not applicable 

to a particular page). 

You can easily select any or all of the combinations and then click Save to have have each page saved 

once for each data graphic applied. 

 

 

 

 

 

 

 

 

 

 

 

If you select the tab “By Data Graphic”, then data graphics are at the top level, and each node lists 

all pages in the document. 

 

 

 

 

 

 

 

 

 

 

 

 

If you select the option “Single File (all pages)”, then the data graphic will be applied to all pages in 

the document, but the saved HTML page will contain sub-pages for each page within the document. 

This can be a very convenient option.  
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6 - Diagram Organizer 

This set of functions is very useful for reorganizing larger diagrams – typically topology diagrams – 

where there may be many tens or hundreds of shapes present. 

 

6.1 - Selecting Connected Shapes 

 

 

Figure 1 – Selecting and filtering shapes in a hierarchical diagram. These options allow you to select 
a complete set of children or parents of a shape, including connectors or not as you wish. 

 

These functions allow you to select a tree of components which you can then copy and paste or 

move around to re-organize your drawing. It is also easy to change the format of shape lines for 

selected shapes to graphically show impact/dependency as shown in the diagram below. 

The functions are available on the right click menu for a shape as shown above. 
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Downwards (Viewing dependencies) Upwards (Viewing Impact) 

 

Part of a Service Map showing “downwards” 
dependencies. This shows a simple mapping of the 
relationships between a business application (ISA 
Payment) and the underlying software and servers 
that support it. The red dashed links show direct 
dependencies for this service. So at the bottom we 
have SV-BHAM-010301 and UK_BIRM_BLADE_01. 

In this instance we selected children and 
connectors of the top item and changed the line 
style. 

 

 

Part of a Service Map showing “Upwards” 
impacts. In this example, a problem with 
UK_BIRM_BLADE_01 at the bottom might affect 
multiple business applications (Workflow Client, ISA 
Payment etc). 

In this instance we selected parents and 

connectors of the top item and changed the line 

style. 

 

 

The Filter > View Connected option will first select all connected shapes (parents, children and 

connectors) and put them on to a special layer. It will then turn off all the other layers in the 

document. 

Filter > Remove Filter undoes the changes in layers. 

Please note that the Filter commands will change the current document as they assign shapes to 

particular layers (Filter/Nonfilter). You may wish to avoid saving the document after applying these 

options – they are useful for interactive display of results. 

 

6.2 - Filtering Shapes 

This function can be quite powerful to hide all the shapes that are not directly connected to the 

selected shapes. It works by selecting all the parents and children of the selected shape(s) and 

putting them on to a layer called Filter, it then puts all other shapes on the page onto a layer called 

NonFilter and hides that layer. 
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Remember to undo the filter before saving your document. 

Filtering a diagram. This shows the diagram after filtering to only view shapes directly connected 
(parents or children) with the currently selected shape. 

 

6.2 - Selecting Shapes by Data 

This function is very useful for selecting shapes by the value of any of the shape data fields that they 

contain. 

Being able to select shapes allows you to do things like: 

• Change colors, or text or line styles 
 

• Change the layer 
 

• Copy and paste a set of objects into another page or diagram 

 
If you have tens or hundreds of shapes in a large diagram then this can become very useful, 

especially if the shapes are distributed around the page making it hard or error prone to manually 

shift click and select them. 
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Select by Data options. These are the options for Select by data, explained below. 

 

Name – this is the name of one of the shape data fields (the drop down is populated with a 

list of all possible values found in shapes on the page. 

Criteria – this is one of “Equals”, “Does not equal”, “Starts with”, “Ends with”, “Contains”, 

“Does not contain” 

Value - this is the string value to compare with. 

All Shapes on Page – this button selects from all the shapes on the page (ignoring any 

existing selection). 

Use Existing Selection – this performs a from currently selected shapes – it is like applying a 

filter to the currently selected shapes (rather than to all shapes on the page). It allows you to 

drill down quickly and easily to smaller subset of shapes, for example selecting first by field X 

and then by field Y. 

Previous selections – contains a drop down of the last 20 selections made – makes it easier 

to re-run recent actions. 

 

Field Names. These include all shape data fields found in shapes on the page. This has selected all 
shapes where field “cabinet_name” equals “47 U” - in this case 17 shapes (also shown in the Status 
bar). 
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With larger diagrams. This has selected all shapes where field “cabinet_width” equals “600” – some 
21 shapes spread around the diagram – we might want to change the fill colour of all these shapes, 
or their width and height in one action. 
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7 - Network Organizer 
 

This is a very powerful tool for laying out diagrams such as network topologies, especially where 

there are multiple connections between individual shapes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Laying out a switch diagram. The switches have multiple connections between each other, each on 
different ports. Using Network Organizer’s Layout Connections option, we have spaced the 
connections appropriately to the best side of each shape. 

 

It is very common to have multiple connections between switches but it is often hard to draw such 

diagrams manually: 

• It is time consuming to create multiple connections and setup up appropriate Visio 
connection points for each shape 
 

• If the network changes and you want to add or delete connections, then you need to change 
the spacing on your connectors – again this is painful if you do it manually 
 

• Changing the layout – moving shapes around the page – also requires you to adjust 
connector spacing to ensure good layout 

 

The Layout Connections button does this automatically: 

• Select the shapes to layout (Ctrl+A to select all shapes on the page) 
 

• Click Layout Connections 
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If you change the relative positioning of a couple of shapes you can adjust their layout just be 

selecting the shapes that changed before clicking Layout Connections. 

 

 

Changing the layout of a diagram. In this example we have moved SW-BHAM-CORE3 from left to 
right. By clicking Layout Connections, we automatically moved the connections from the left side to 
the right side of SW-BHAM-CORE2, and adjusted the relevant spacing on each side. 

 

7.1 - Showing and Hiding Ports 

We have used a custom connector with shape data to make it easy to Show or Hide all the ports in a 

diagram. 

 

 

Hiding (or showing) ports. The connector shapes have a menu option for this. 

 

Note that this specific example uses the shape data fields produced by AssetGen’s Connect product - 

but the same principles can be applied to other sources of the information. 
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7.2 - Power Topology Diagrams 

 

This type of diagram which shows power distribution in a data center from PDU to power strips to 

servers, can be very useful. 

 

The more connectors you have (power strips and servers for example), the more you need Layout 

Connections. 

 

7.3 - Switch Connections 

It is common to draw diagrams showing devices connected to a switch or patch panel – easy with 

Layout Connections. 

 

In the example above, we have used a data graphic to show the cable ids for each patch cable 

(requires the data to be maintained – in this case done by AssetGen Connect). 
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This makes for powerful audit tools, or you can produce design documents which are very easy to 

use as complete build instructions. 

 

7.4 - Matrix Layout 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Matrix Layout feature provides a quick and easy way to arrange many shapes into rows and 

columns for displaying data or building your own Visio shape to represent a Patch Panel or a set of 

ODF trays. 
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Select more than one shape and click the Matrix Layout button in the AssetGen ribbon. At the top, 

there is an option to arrange the shapes by a certain parameter or by the text their labelled with. 

Change the options in the format section depending on weather you want the shapes arranged into 

columns or rows and then change the number underneath to dictate the number of those columns 

or rows. Spacing is automatically set to edge to edge shape placement but you can also have a set 

interval between shapes.  

 

8 - Miscellaneous 
 

8.1 - Remove ShapeNum Event 
 

The Visio Shape Numbering add-in (in 2010 available from View -> Add-Ons -> Visio Extras -> 

Number Shapes) can be very useful. 

 

 

 

 

 

 

 

Unfortunately, it has a side effect, in that it adds a Persistent Event to the Visio document which 

turns out to be remarkably difficult to remove! 

 

If the document is saved Read-Only then you will get the following error message if you open it again 

within Visio: 
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The event is visible if you turn on Developer tab and look at “Persistent Events”: 

 

 

 

While you should be able to delete it from this dialog, it doesn’t always work. 

 

The AssetGen Visio Utils button “Remove ShapeNum Event” will correctly remove the event. 

 

8.2 - Resize Shape 
 

This feature makes resizing multiple shapes easy. The measurements shown in the two fields are 

from the master shape and can be changed to just change the size of the master shape or all the 

shapes selected. 
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8.3 - Text Layout 
 

This feature allows the you to change the alignment and direction of the text in all the shapes 

selected. The user can select the shapes text to be Horizontal or Vertical (top to bottom, bottom to 

top), and how its aligned, top, middle or bottom. 

 

 

 

 

 

 

 

 

9 - About Functions 
These are available from the last group on the ribbon: 

 

9.1 - Show Help 
 

Displays this help document in your currently installed PDF reader. 

 

9.2 - About AssetGen 
 

This is a link to the AssetGen website, where you can get more information on AssetGen and 

download a trail version of Connect and SysMap, software to help with documenting complex 

infrastructure.  


